Internet Services from the
CBSC

1. Business Start-up Assistant

The digital age has enabled the Canada/
NWT Business Service Centre to
provide new NWT businesses with a
unique interactive service, called the
Business Start-up Assistant. This unique
service offers valuable information that
can help you to develop your business,
including:

* Market research;

< Business name and structure;
< Preparing a business plan;

e Financing;

» Taxation;

< Hiring employees;

« Doing business on the Internet;

... and more.

The Business Start-up Assistant can be
accessed on the Internet at
www.cbsc.org/bsa.

2. Interactive Business Planner

Another unique source of information is
the Interactive Business Planner. It is the
first small business planning software
designed specifically to operate on

the world wide web. This interactive
online tool will help you prepare a
comprehensive business plan for your
new or existing business. This service
is effective, easy to use and absolutely
free. It can be an invaluable source,
saving you time by:

< Providing online help with a simple
click of your mouse;

e Saving your plan on the site’s server
with password protected access; and

< Allowing you to download your plan,
print it and use it to obtain financing.

Save yourself the time and effort of
trying to do everything yourself. Check
out the Interactive Business Planner at
www.cbsc.org/ibp.

. Online Small Business Workshop

The Online Small Business Workshop
(OSBW) is a web-based workshop
designed to provide you with techniques
for developing your business idea. It

is organized into five sessions, each
focusing on a different area of business.

Session 1 - Starting with a Good Idea

Session 2 - Marketing Basics

Session 3 - Financing Your Business

Session 4 - Planning Fundamentals

Session 5 - Basic Regulations for
Getting Started

The OSBW can be found at
www.cbsc.org/osbw.

Of course, if you have any questions,
remember an Information Officer is
there to help during regular business
hours. Any way you look at it, we’ve got
you covered.

How to start selling online
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Welcome to
E-Commerce:

A general definition of e-commerce is that
it is the exchange of goods and services
over the Internet, including the transfer of
funds. This means anytime you buy a piece
of clothing or pay for a service like cable TV
online, you are participating in e-commerce.
It is much bigger than just shopping online
though. It also includes any time you provide
money for something over the
Internet. If you can think
of it and sell it and
someone buys it
from you using
the Internet,
then that’s e-
commerce.

E-commerce is becoming more popular as
more and more people have high-speed
Internet and are becoming comfortable with
buying things online. Many experts predict
that e-commerce spending will grow faster
than traditional retail sales in the years to
come.

Not just e-commerce veterans are benefiting
from the increased use of the Internet
though. Even traditional retailers like your
local sporting goods store owe some of their
success to e-commerce. Their customers
use the Internet to research the item they
want to buy and compare prices, but still go
into the store to make the actual purchase.
Market research and sales reports often miss
these online shoppers, but there are more
and more of them as e-commerce grows and
expands.

The North is a very small market for any
product or service. There are not very
many customers walking by stores or large
populations to buy your service. By opening
your business to the billions of people using
the Internet, you can increase your sales
beyond the limitations of living in the North.

The Internet and computers are driving most
of the business in the world today. This
means, as well as having more potential
customers, competition is getting closer as
well. In order to prepare for doing business
now and in the future, you need to learn
about selling online.




gives you information about the buying
habits of your customers. This can be
used to improve marketing and pricing

There is a lot to be gained, and a lot of strategies.

money to be made from selling your product
or service online. Some of the benefits of
selling online include:

< Inventory, shipping and purchasing
controls: An automated system is
immediately put in place to control

« Global market: Businesses can sell their inventory, process orders and ship
products to a huge base of consumers. product.
The more potential customers you have, It is actually quite easy to get yourself up
the more potential you have to make and running on e-commerce. Follow these
money. steps and you should be well on your way to
« No middleman: The more “hands” promoting your site and product instantly to
a product passes through between millions through e-commerce.

it being made and being sold, the
more that product will cost. With e-
commerce the sale can be done in as
little as one transaction.

« The little guy can look big: Small
businesses can compete with larger
ones.

« The store is always open: Online
shopping can happen at any time of day,
making it easier for customers to buy
your product.

< Happier customers: If your website and
order filling procedures work well, your
customers are in charge. They can buy,
ship, track and return orders easily.

« Lower marketing costs: Word of
mouth, email, and search engine-
recommended lists all contribute to the
success of an e-commerce venture.

« Lower overhead costs: Maintaining a
website is much more affordable than
the staffing, rental, and other costs
associated with typical retail stores.

« Better knowledge of your customers:
Having online clients set up accounts
with your site not only makes it easier
for your customers to shop when they
return to the site the next time, it also




Some experience and a good understanding
of how computers and the Internet works

is essential before you begin e-commerce.
This book does not recommend that people
with no experience begin selling online
because mistakes can be costly. Also, being
comfortable with computers will help you go
through the steps in this book and make the
decisions for selling your product or service
along the way.

Ask yourself some of the following questions
before you go any further:

* Have | used a computer before?

* Do | have access to a computer when |
need it?

* Is my product something that can be
bought online (plumbing services for
example are not, but selling carvings or
arts and fine crafts is)?

« Do | know where to find help if | need
it?

If you answered “No” to any of the
guestions above, you should not go through
this booklet and try to start selling online
right away. The good news is that it is very
easy to get the basic knowledge to catch up
and be in a position to start selling online.

It is important to
have some basic
understanding and
knowledge of how
to use computers

and the operating systems that run them
(Windows 98, Windows XP, Windows 2000,
Linux or Mac OS X). As well, you should have
a sound understanding of the Internet and
what the Internet can do as an information
and marketing tool. If you do not have any
knowledge of these things or are very new to
computers and the Internet, here are some
good resources that will provide you with the
basics that you will need to get started.

1. Aurora College

Talk to any of the three campuses or one
of the community learning centres to find
out about the courses they offer. There are
many introductory level courses that will
help you with the basics of business and
computers.

2. Academy of Learning

Located in Yellowknife, this company
allows students to progress at their own
pace and has specific courses for many
different computer activities and levels of
experience.

There are other resources available to you
throughout the NWT. Use the Appendix
at the back to find some of them or talk to
someone in your community that can help
you.

Are you ready to start learning about
e-commerce now? If you’ve thought

about this and have the basic knowledge
necessary, then you’re almost ready to start
the process that will get you selling online.




Once you have completed training yourself
on both computer operation and becoming
familiar with the Internet and basic concepts
of how information is found and shared,

you will need access to the following items
before you start selling online.

1. Computer (these are minimum

requirements)

a. Intel Pentium or equivalent

b. Windows 98SE/2000/ME/XP/NT4.0/
SP6.0 or higher

c. 64 Mb RAM (128 Mb RAM
recommended)

d. 25 Mb hard disk space

e. Word processing software such as MS
Word

f. CD Rom drive

2. Internet access

Local dial-up, high speed cable or Digital
Subscriber Line (DSL) connection.

3. Computer software that supports
development of e-commerce sites or
website design
You will need to be familiar with how to
use this program, or the basics of it at the
very least.

4. Email account

Hotmail, Yahoo!, Excite, Gmail or one that
comes with your Internet access.

5. A company who can host your website
Such as the company you get your
Internet and email from or one of many
other options available.

6. Scanner or digital pictures of your
products (JPG, BMP, TIFF or GIF files)

7. Bank account number

8. Credit card (this is not mandatory)

Start a checklist as you read through the
information in this booklet. Make note of any
areas that are of particular interest to yourself
and the type of e-commerce solution that
you are interested in as you read about them.
Use the Glossary at the back if you come
across any words you need explained along
the way.

Note: Depending on the type of
e-commerce solution you set up, some
things may not be necessary or you may
need software or hardware not described
above.




Although there are several options available,
there are five broad categories for
e-commerce businesses. This section will

help you figure out which one is right for you.

The five categories are:

e Brochureware

* Auction sites

Online stores

Online malls

Subscription sites

While not an option for e-commerce
business, PayPal is the most popular and
easiest way to accept payment over the
Internet without expensive bank charges.

e PayPal

Brochureware refers to a site that takes

a company’s printed brochure and puts it
into a web format. Simple, but effective,
brochureware sites give new and existing
customers valuable information like
company mission statements, store hours
and locations. Brochureware is often the
way many companies with existing sales
channels or locations enter the online world.
Product information and phone numbers can
also be a part of the site, but the final sale
isn’t completed online.

Outdoor recreation retailers
often have brochureware
websites. While no
selling is conducted
online, the website
is used to
communicate
with the stores’

customers and provide information about
upcoming events and featured products.

The site should be regularly updated and
contain relevant features like a “Staff Picks”
section of staff-recommended products.
Other industries that may use brochureware
include tourism outfitters (for guided trip
descriptions) or not-for-profit organizations (to
share information about upcoming events).

Is brochureware for you? If you are only
looking to have an online presence but still
rely heavily on customer service to close
the sale, this solution may be best. Often,
your expertise may require speaking to your
customers. In this case, your main goal

is to have customers call you so you can
demonstrate your knowledge and describe
your product.

How to get started with brochureware is
described in the step-by-step instructions at
the back of this book.
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Auction sites have become very close to
online malls. For the most part, there are
now only three main players in this category:
Yahoo!, eBay, and Amazon. However, a
number of smaller auction sites exist on the
Internet. You should approach these with
caution as they may generate very little traffic
and be a waste of your time and money.

and other auction sites are just like
a traditional auction with paddles and bids; a
seller puts something up for sale, interested
buyers place bids, and the item is sold to the
highest bidder. The only difference with an
auction website is that it all occurs online and
the auction can last for days.

Auction sites can be used in many ways.
They are e-commerce businesses
themselves, where the owner sets up the
site and charges buyers and/or sellers for
access and transactions. Another way to
use auction sites is to make one a part of
your online store to move discounted and
discontinued items.

For most companies, using another
company’s auction site is easier than setting
up your own. Many stores use sites like eBay
to market their items because they know
that there are millions of people visiting these
auction sites every day. Just like online malls,
there can be setup costs for auction sites,
but they are usually low and sometimes free.

Books have been published on how to
effectively sell items on eBay. See the
Appendix for recommended books.

An auction site may be best for you if a
picture of your product is enough to sell it.
Arts and fine crafts fit this category very
well because the visual image and the
written description are enough to convince

the consumer to purchase the product. Try
asking yourself if your product is something
that you would look for and buy on eBay
yourself, or try looking for similar products.
This will indicate the level of interest on
auction sites for your product.

How to get started with auction sites (eBay)
is described in the step-by-step instructions
at the back of this book.
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The online store is the most typical form of
e-commerce. Just like brochureware, you
can find company and product information
at the online store. But with an online

store customers can buy the products

and the owner can track those purchases.
To be effective, it is very important that

an online store provides very detailed
product information. This attracts potential
customers, and it gives them the confidence
in your product and your company, to actually
make a purchase.

The NWT Development Corporation operates
Arctic Canada Trading Co. Perhaps the
broadest online store in the NWT,

is a good example
of what the typical online store looks like.
The Shopping Cart feature allows customers



to pick items and put them aside while they
continue shopping, and then proceed to
“Check Out” when finished shopping.

Online stores are a bigger commitment and
will be right for you if your product has the
most appeal to customers outside of the
NWT. Some art galleries in Yellowknife have
been very successful selling northern art
and carvings using the online store type of
e-commerce.

How to get started with your own online
store is described in the Step-by-Step
instructions at the back of this book.
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Like a real shopping mall, an online mall
provides the infrastructure, address and
traffic for retailers. Online malls can provide
small businesses with product catalogues,
shopping carts and secure transaction
processing. The user gets all of this without
the cost of custom development or internal
hosting. Even though there are often
transaction and/or subscription fees for using
an online mall, for a smaller company or
startup venture with fewer transactions, the
online mall is a great way to get started.

Yahoo! Store is one of the biggest online

malls and has a Canadian version at

. It hosts more than
10% of all online stores. It offers web
space, shopping carts, online catalogues,
order management systems, discounts on
marketing services and technical support.

An online mall gives you a chance to test
how much demand there is for your product.
If you don’t have high sales now, but want
to start selling online, this is a good option
for you. For example, you may not want to
develop a full online store for moose hair
tuftings, but want to try e-commerce. Setting
up your own store within an online mall may
then be the solution for you.

How to get started with online malls (Yahoo!)
is described in the step-by-step instructions
at the back of this book.
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Subscription sites target customers with very
specific or particular interests. They offer
expert information, services or products.
Newsletters, technical information, financial
advice, research reports, videos, music,
graphics and computer games related to an
interest are sold on a monthly or transaction
fee basis.



The most familiar subscription site in the
North is likely Northern News Services Ltd.
As publishers of News North, Deh Cho
Drum, Inuvik Drum and the Yellowknifer,

offers online access to full
news stories only to subscription holders.
The technique used by this site is to give all
visitors access to recent headlines, however
only subscribers can access the full story and
the archive.

Subscription sites are great for service-
oriented people. If you provide information
like summaries of media coverage about the
oil and gas industry in the NWT, you may
want to offer the latest headlines for free
and then charge people subscriptions to
view the full analysis. This way, you promote
your business online but hold back the real
product for those subscribers that pay for
your service.

How to get started with subscription sites is
described in the step-by-step instructions at
the back of this book.
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Organizing and accepting payment can be
very difficult if it’s your first time trying to sell
online. PayPal is an Internet-based banking
service that makes this very easy. By setting
up your account, you can accept all the
major credit cards from customers wanting
to purchase your product online. Without

a service of this type, you have to rely on
the mail or couriers to exchange the money
instead of just mailing your product once the
funds are confirmed by PayPal.

PayPal is a service that will work with any of
the e-commerce options described before
this, from your own online store to getting
started on eBay.

How to get started with PayPal is described
in the step-by-step instructions at the back of
this book.



While it’s easy to get carried away in the
excitement of starting your own e-commerce
business, slow down and do some planning.
The more effort you put into the planning
stage, the more likely it is that your business
will run smoothly and make money.

Make sure your business plan answers the
following questions:

< What do you want your website to
accomplish?

* How will you make money?
« How wiill your customers find you?
« What makes your site different?

< How will you deliver your product or
service?

* How will you maintain your website?

« How will you help and serve your
customers?

 What will demand be?

< Are you able to meet that demand?

While they may not come up in this order
for every business, these questions are
really the same as those asked in a normal
business plan. Make sure you have a solid
business plan in place before starting any
e-commerce business.

For information on how
to write a business

plan, contact the CBSC office or visit

and review the
document “How to Start a Business in the
NWT.”

Design

There are many good books on website
design that go into far more detail than this
guide. How fast your home page loads and
each page after that loads is very important.
In e-commerce, faster is better. Your home
page should be attractive, inviting, and above
all, simple. Use it to draw your customer

in, and then make sure to give them the
navigational tools to discover more.

Another good idea is to be consistent with
your choice of font, design and layout styles.
While multimedia tools can seem like a

fun idea, ask yourself if you would wait 30
seconds for a logo to erupt into flames or

to have a school of fish follow the cursor.
Unless they tie-in to your marketing strategy,
they will take away from the integrity and
success of your online store. Only use them
if they help keep customers on your site.

For example, if you wanted to attract
Japanese customers, there are a number of
things you could do. Using lots of images

of the Northern Lights would help, as most
Northerners are familiar with the Japanese
fascination with our northern light show.
Having Japanese/English translations will
also help those visitors with weaker English
skills. Most importantly though, visit some
Japanese e-commerce sites to find out what




works for them in their own country and try
to fit your product to a proven design for the
Japanese consumer.

Domain names
Choosing your domain name (your website
address on the Internet) is an important step.
It is what you type into your web browser’s
menu bar, and is a way to personalize your
address on the Internet. This will make it
easy for people to find you. You can find out
what domain names are available by going to
. You should pick a
name that:

* makes sense;
= is easy to remember; and
 is as brief as possible.

Once you’ve chosen your name, you will
have to register it. The information you

will receive from the Canadian Internet
Registration Authority ( ) will be
needed later when you are setting up your
website.

Note: Registering your own domain name
only applies if you plan on opening up your
own store. Brochureware and auction sites
for example, will not require your own
domain name. In those cases, part of what
you are paying for is the traffic their domain
name (like eBay) already generates. See the
Step-by-Step instructions for details specific
to the type of e-commerce you have chosen.

Site maps

With your plan in place, you’ll need to
consider how to approach your website’s
structure; that is, how people go from page
to page on your website and where they will
find the information they are looking for. The
best way to lay out your website is to begin
with a site map. The site map is a diagram
that maps each page of a website. Also

called a storyboard, it helps you build a site
that meets your needs and is also easy for
your customers to find their way around.

A good site map is developed after you’ve
completed your business plan. That’s where
you will figure out what your customer needs
and wants and will have answered all of
those unexpected questions that come up
when you're starting a new business.

If you start to plan your website earlier, you
may waste both time and money because
you will have to go back and change the way
your website works. You only want to have
to build your website once.

As well, the site map shows the skeleton

of the website, displays links between
pages and describes how each page is
represented. Some maps also include visual
elements, page numbers and descriptions of
the images. This way it is clear to everyone
involved in the project how to navigate
through the site and what happens with
each click of the mouse, BEFORE you start
building the actual website.

If you like the idea of hosting your own e-
commerce website, but don’t want or need
the high cost of custom development, there
is software available that you can use to set
up your own online store hosted on your
server. They usually include a shopping cart
of sorts, a database to load your product(s)
into and the ability to process transactions.
The overall design may not be as exciting as
it is with a custom design, but the program’s
templates really help to cut down design
development and testing time. A potential
issue is that the software doesn’t usually
show you the programming code. This
means you can’t really change the process



of how your site works and if there are
problems with your site, you have to call the
software company for help.

Knowing your customers and managing your
sales orders can be one of the most difficult
issues you will face. A relational database or
customer-relationship-management product
helps you organize your customers and
orders.

The company that makes Maximizer, a
popular customer-relationship-management
product, also sells ecBuilder

( ),
an easy-to-use e-commerce store in a box.

A beginner can use this software and follow
the prompts to get a website and catalogue
up and running in minutes.

4th Dimension (4D), a popular relational
database company, sells the 4D business
kit ( ).
Like ecBuilder, it's a web server, multi-store
manager, and database all in one. 4D works
on PC and Macintosh computers. It can also
be extended with the 4D database system.

These packages need a computer and high-
speed Internet access. They make it easy
to get started and let people browse your
catalogue, but you may still need a technical
consultant to make sure the processes run
smoothly and that you’re connected all the
time.
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In some ways, website services, such as

Yahoo! Store, can really take the worry out of

e-commerce. The advantages to using these
services include:

* No worrying if the server is going to
startup properly after a power outage;

* Your high-speed Internet connection is
always working; and

* The viruses (infections to your computer),
fire, or theft of equipment that could
“close” your store for some time are
someone else’s worry and responsibility.

Instead, these problems are left up to your
service provider. Their system is likely to be
much better than what you can purchase,
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and they have full-time staff who are well-
trained in making sure everything is working
the way it’s supposed to.

Yahoo! Store, eBay, and

are all examples of all-in-one website
service providers. Web hosting providers like

and are

also in the business of helping people start
online shopping carts and managing their
stores. With many of these service providers,
you can literally have a store up and running
in a matter of hours.

Hosting refers to the computer where you
put the files and programs that make up your
website. If this computer is in your office and
controlled by you then that is called hosting
internally. Hosting externally is when you
have another company provide this service
for you.

While it can be a challenge, in the long term,
hosting your server at your place of business
is often the most rewarding way to have an

online store. It has the highest start-up costs,
but the longer you have the business running
the less the investment costs you over time.

If your site has more pages or your
business is doing more transactions than
the average site, bringing the development
in-house might be the right thing to do.
Before deciding, make sure you have the
right equipment and access to high-speed
Internet.

A very popular way to start up an e-
commerce business is using the services
of a hosting provider. Hosting providers
can publish everything from a single page
website to a giant, multi-national,

e-commerce store. Use the table on the next
page to see which option would work best
for you. Make sure you’re realistic about the
money you have to spend and the technical
ability of the people that will help you run
your business.




Internal vs. external hosting

Advantages

Disadvantages

Internal Hosting

Everything is
customized for your
business

Custom software development

is expensive

No transaction fees
(other than merchant
accounts like Visa and
Mastercard)

Must have high speed
internet service, all day
every day

Your e-commerce site
can be as big as your
imagination. The size
of your server(s)
determines your
capacity

The cost of security
certificates and renewal
every year

Accounting functions
can be custom built for
your business

Administration and
maintenance of
equipment are required

External Hosting

Very high-speed
service available

Your virtual storefront
is not located at your
business

Security certificates
and merchant account
setup often provided by
hosting service

You are charged
transaction fees and
hosting fees

Equipment and
connection managed
by provider

You must depend upon
a third party to keep your
store running all the time
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If you are considering hosting your own site,
either with a custom-developed server or an
off-the-shelf package, the information in this
chapter is very important. If you are using an
online service for your store, you may wish
to read about security first so you can ask
your service provider questions regarding
their security policy.

Internet security is very complicated; this
chapter will only give you basic information.
If you can, it would be a very good idea to
hire a security specialist to evaluate your
plan and help you set up a store that can’t
be “broken into”” by computer thieves or
viruses. Spending that money now may save
you from losing a lot later.

The costs of not having a sound security
policy can be enormous. Theft, fraud,
lawsuits and store downtime can all be the
unfortunate consequences of poor security.

Firewalls - provide protection from the
general Internet for your servers. These
help protect against viruses. McAfee is an
example of a firewall protection software

program you may be already familiar with.

Access control - the security of usernames
and passwords is a high priority.

Encryption - data coming in and out of
your server is encrypted. This means

that dishonest people trying to read the
information while it’s travelling from one
computer to another won’t be able to
understand things like credit card numbers
and personal contact information.

Vulnerability testing - make sure your
e-commerce software has been tested for
attacks and any holes are patched before
your site is live on the web.

Virus protection - software packages like
Norton AntiVirus and firewalls can help
prevent viruses from invading your computer.

Viruses - programming code that invades
your computer or system. It is usually
transferred by email and can severely
damage or ruin your system.




You will need to decide what you want your
marketing to do:

You’ve got your website running well. The

online store is open and ready for a flood of 11 )
o . Increase product awareness;

customers to come clicking in. How are they

going to know where to find you? What is 2. Increase traffic to your website;

going to drive them to your store? Marketing

o ) o 3. Promote special events or sales; or
your site is as important as building your

site. It is best to ask an expert for help; 4. Rank your site higher with search
general marketing solutions don’t often engines.

provide results as they don’t take the people

in your target audience into account. See While marketing online may be obvious for
the Appendix for recommended books and your e-commerce site, sometimes traditional
websites. marketing may work as well. Make sure

you use the methods that give you the best
combination of budget, size of audience,
targeting of audience and of course, results.

Some common methods include:

Banner ads on other websites

Pay-per-click programs

Links on other websites

Search engine optimization

Category links on search engines

Electronic newsletters or email updates

= Magazines or newspapers

Direct mail

Event sponsorship

< Promotional giveaways
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The easier it is to find your site the
more traffic you’ll receive. If advertising
online, look for opportunities that

are already attracting visitors with a

northern interest. The “awareness
advertising” by others will make your
product easier to sell to an established
audience.

Most importantly, the mix you choose has
to communicate your audience-message
clearly, engage the audience and get results.

Targeting your customers

Knowing who your customers are is the
cornerstone of a good marketing strategy.

If you plan to sell outside of North America,
you have to consider some additional issues,
such as language translations, money
exchange, taxation, and shipping issues.

Beyond the technical issues, proper
marketing also depends on what you know
about your audience personally. How old are
they? How much money do they spend on
products like yours? How often do they buy
products like yours? What are their other
interests? Knowing this type of information
helps you develop marketing plans that wiill
sell your product. Even if you don’t start out
with this type of information, you can gather
it along the way by interacting with your
customers.

Search engines - getting your
website found first

In order for people to find your website on
the Internet, you must be listed with a search
engine. Examples of search engines are
Google and Yahoo!.

There are three ways to get listed:

1. Wait for the search engine to find your
site and save it in its database. This
can take up to six weeks (or more) and
each time the website changes it can
take another six weeks to register the
change.

2. Register directly with each of the search
engines (which can be costly).

3. Use one of the site submission services
(for example, www.macromedia.com)
that registers your site with multiple
search engines at once (more
economical).

Here are a few tips to make sure that your
site is toward the top of search engine lists:

« Title: The headline for your website is
the first thing search engines use to
register your site. Be sure it is punchy,
descriptive and effective.

e Text: The first 25 words (or 255
characters) of your home page are
indexed. It is best to write it so that it
contains as many keywords as possible.

Google
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You can even hide this with an image
placed at the top of your page that is
not seen by the audience by making the
background and font colour of the text
“clear”.

« Keywords: These are target words
that will direct people to your website.
Keyword strategies:

i. Avoid plurals, such as ““boats”
instead of “boat”. Searching “boat”
will find “boats”, but searching
“boats” will not find “boat”.

. Never use common terms like
“web”, “Internet”, “net” or
“services” as they are ignored by the

search engine.

iii.Include incorrect spellings of words
that are commonly misspelled.

« Meta tags: These are words search
engines go looking for when they
receive a search request. List your
keywords here and include meta tags
on every web page you publish. Talk to
your web designer about this.

e Link popularity: This refers to not only
the number of sites that have your
website referenced, but also to the
number of links to other websites that
you have on your site. This is tricky, as
search engines ignore sites that are only
links, but will rank your site higher if
you have more websites connected to
yours.

Another way to get found is by hiring a
search engine optimization consultant, but
this can be expensive and results are difficult
to prove. These professionals help to get
your site found for even the most generic
search terms.

There is software available to help you get
a high ranking with search engines without

being penalized for “keyword stuffing”
(using excessive amounts of key words).
These points will get you well on your way,
but make sure to learn about it. The more
knowledgeable you are about developing and
managing your site, the more likely your e-
commerce business will be a success.

Links are connections between your site and
another site, or from one page to another
within your site.

Broken links are a huge problem on the
Internet. Some say as many as 10% of

all the links on the Internet are broken.
Would you ever trust a company who gave
you directions to a dead end? Many links
management applications are available that
can help you with this problem.

Link Checker Pro:
Does just what
it says and is inexpensive.

Change Agent:

Similar to Link Checker Pro and works well
with other applications.



Link to as many like-minded businesses
and organizations as possible. It will
help consumers find your site, and

odds are, consumers interested in one
northern product will be interested in
another. It is proper to always ask for
permission to link to another site.

Maintaining and managing
your site

Making sure your site stays up-to-date

with the changes in your company and the
changes in technology can take a lot of
effort. However, this effort pays off when
users visit your site and find it interesting and
full of new information that’s useful to them.

If you’re not sure where you can make
improvements, the best people to ask

are your customers. They will like being
asked for their opinion and you will have
suggestions that will keep them buying more
product from your business. As they’re at
least once removed from your business,
they will see things differently and offer
suggestions that you and your team would
never have thought of. A simple survey that
pops up when someone visits your home
page or an email survey (if you have your
customers’ email addresses in a database)
can produce some great results. If you can
afford to hold a draw for a prize for everyone
who completed the survey, you may get a
better response.

Set up a maintenance system that is easy
enough that the person in charge of doing
it can be replaced with someone else with
little training. How complex your site is will
determine how complex the update system

will be. One suggestion is to keep a website
maintenance log. Every time the person in
charge makes a change, it’s noted in the

log and they also include why the change
was made. While it may seem like it would
take up a lot of time, think about how much
time it will take the next person to take

over maintaining the website without this
information.

Content management

Use software to your advantage. There are
many applications that can help you maintain
your site. They let people with very little
technical knowledge edit and contribute new
content.

Site management software: NQcontent
www.nqcontent.com

Easy to use content management: Vignette
www.vingette.com

Keeping your site current and fresh will
keep consumers coming back. Always keep
your database of products as up to date as
possible.

Very few businesses get it 100% right the
first time their site goes live on the Internet,
but the ones that are successful keep moving
toward that goal!
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The first step is to have a strategy. Too
often, online marketers focus on marketing,
technology and delivery of the product
without having a good system for handling
simple emails from customers. People think,
“we’ll cross that bridge when we get to it”,
but sometimes the bridge arrives before
anyone realizes and customers end up down
river at another site. Have you ever sent an
email to a business only to wait 3, 5 or 7
days for a response? How does that make
you feel about the company?

Sometimes it is a company’s success that is
their downfall. The more orders that come
in, the busier the people get who are filling
them. Make sure that there is someone who
is there to talk to customers or to respond to
emails, otherwise you may lose business to
other companies who do make a priority of
consumer inquiries.

To see if your strategy is going to work
effectively, ask yourself these questions:

* How is the customer service department
going to handle every part of a transaction,
from customer questions, to delivery, to
returns and complaints?

« Is there a Frequently Asked Questions
(FAQ) list on your website that is easily
accessible?

e Can a customer login and check the
status of an order?

* Do all the emails and calls get
responded to within one
business day?

= Can customers

easily call and talk to

a human?

« Does the website provide the ability
to automatically email customers with
updates if they request it?

Your best bet is to provide as much
information as possible on the website. If
you want to encourage customers to contact
your company by email, put a 24-hour return
email policy in place. By being responsive
and making sure the ordering process is

as automated as possible, phone calls can
be avoided. If a customer does pick up the
phone, having a real person with access to
the order status is the ideal situation.

Growth is the goal, but as you grow

your business will likely become more
complicated as you have to deal with a
larger number of orders and more shipping.
Managing the current level of activity and
being prepared for growth is the best way to
achieve success.

Logistics
The term logistics refers to the various
systems you have in place in order to do
business. After you've gone to all the effort
of planning the setup and marketing of your
online venture, consider these questions:

< How will you process orders?

« How will you handle multiple

suppliers?
< How will you deal with errors?

< How will you handle returns?

Shipping

Another issue an online business has is
shipping. In the NWT, this presents an even
greater challenge. Sometimes it costs as
much to ship an item as it does to buy the
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actual item. This challenge can be addressed
in many ways. Encourage customers to buy
several items at once, use slower shipping
methods that save money (postal service, or
2 day services) or focus on selling specialty
items that are of a higher value. Ask yourself
these questions:

* What couriers will be used and how will
shipments be tracked?

« Can customers track shipments online?

e Can customers choose their couriers?

* How will you charge for shipping?

e Can customers ship to multiple
destinations?

e What do you do if an order is lost or
damaged during delivery?

International orders

The global nature of the Internet and the
potential to market to the global audience
is tempting. Before doing so, answer these
guestions:

« How will you handle currency exchange?

« How will you handle duties, taxes and
customs clearance?

e Can you ship your product internationally?
Some countries limit the import of food
and animal items, such as whalebone
carvings. This can be a problem for an
export based business that is just starting
up.

« Are you prepared for additional
international shipping charges?

Although this chapter asks more questions
than it answers, it should help to get you
thinking about the issues that will come up
as your business gets off the ground.
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Stop! This book
is not for you.

Let’s Go!

Check your equipment.

What type of e-commerce is best for you?

e oy w =X

Auction Online Online Subscription

Brochureware sites stores malls sites

Getting started: planning, design,
software and hosting. Use the
step-by-step instructions.

Customer service and fulfillment.

Marketing your e-commerce site: marketing
planning, targeting customers, search engines, links
management and maintaining your website.
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Appendix

The following are suggestions only and
are not comprehensive of all services and
products available.

List of books for further
reading

Selling Online: Canada’s Bestselling Guide
to Becoming a Successful E-Commerce
Merchant , Revised Updated. Jim Carroll,
Rick Broadhead

E-Commerce: Fundamentals and
Applications. Henry Chan, Raymond Lee,
Tharam Dillon, Elizabeth Chang

eBay For Dummies: 4th Edition. Marsha
Collier

List of websites for further
reading

Industry Canada Digital Economy:
www.e-com.ic.gc.ca/epic/inernet/inecic-
ceac.nsf/en/home
http://strategis.gc.ca/ebizenable

E-commerce info:
www.ecommerce-guide.com
www.online-commerce.com

Website creation:
www.creating-a-site.com

Online hosting:
www.shopsite.com

Building your website: There are many
companies that will be able to help build your
site. Check your local telephone or business
directory.
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Applet - Small programs that can be
downloaded and used by any computer.

Application - A software program that
performs a task. Internet Explorer and
Microsoft FrontPage are applications.

Bandwidth - How much bandwidth is
available to you determines how much
information can be transferred over a given
communications link.

Bookmark - A feature offered in a web
browser that stores a website’s location in
the user’s browser.

Brick-and-mortar - Refers to a traditional
business with real buildings and facilities.

Browser - The software that comes with
your operating system used for surfing
the Internet (such as Internet Explorer or
Netscape).

Call center - A place where all customer
service calls are answered and handled.

CGl script (Common Gateway Interface)
- A program that, when running on a server,
provides interactivity for the web user.

Client/Server - A client is a computer
or application that is served by another
networked computer, called a server.

Cookie - Cookies are relatively harmless

and allow a website to “know” who you

are when you visit, without re-entering
information. Technically, they are text strings
of information on your computer.

Database - A computerized “filing cabinet”
that allows for the storage and retrieval of
data.

Domain name - The unique name or address
of a website. eg: and

DSL (Digital Subscriber Line) - Using
ordinary copper telephone lines, provides
high-speed Internet service.

E-commerce - Trading goods (buying and
selling) over an electronic communications
system, such as the Internet.

Email - A method of exchanging
mail messages over an electronic
communications system.

Firewall - Hardware or software that protects
one computer network from another.

FTP (File Transfer Protocol) - An Internet
protocol that allows you to transfer or share
large files.

GIF (Graphic Interface Format) - An image
encoding format that allows for the display
of graphics on screen. Using GIF files on a
website is better because they’re smaller
files which makes your site load faster.

Home page - The main page of a website
that normally serves as the starting point for
navigating around the entire site.

HTML (HyperText Markup Language)

- A programming language used to create
documents on the Internet with tags and
attributes that define how a document is
formatted.

Internet - A public global network of
computers that exchange data.

Internet Merchant Account (IMA) - Enables
a merchant to accept credit cards over the
Internet. IMAs can be obtained through an
ordinary bank.
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IP Address - A unique identification number
that locates computers, servers and devices
on the Internet: eg: 192.168.1.1 is an IP
address.

JPEG (Joint Photographic Experts Group)
- A compression technique used for
photographs. Their small size makes them
the most common file type for photos on the
Internet.

LAN (Local Area Network) - A short
distance data network that provides
communications between computers at a
local site.

Merchant Account - A business account at a
financial institution that processes credit card
transactions.

Meta Tag - A part of HTML programming
that usually describes the type of information
or products found on a website. Located near
the beginning of the page’s source code,
search engines use meta tags to index pages
by subject.

Multimedia Tools - Software programs or
techniques that engage the audience with
site features other than static images. For
example, moving text, fading images, motion
video or sound.

Operating System - The software that
controls all of the computers operations,
including memory, disk, printing and
networking.

Payment Gateway - An online system for
real-time charging of credit cards when a
customer places an order. Normally requires
a merchant account.

PC (Personal Computer) - A computer
designed for use by a single person.

PDF (Portable Document Format) -
Technology by Adobe that allows for the
creation of documents that can be viewed
and printed. These files depend on the
person receiving the document having the
program Adobe Acrobat Reader, which is
free.

Plug-ins - Software modules that add on to
the host program and enhance functionality.

RAM (Random Access Memory) - Data
storage in the form of computer chips.

Search engine - A database system
designed to index websites and then retrieve
their addresses based on the input of key
words, like a company’s hame or a type of
product.

Security certificate - A unique code used by
encryption software to hide information sent
over the Internet. Security certificates make
sure that people, who aren’t supposed to,
don’t see things like credit card numbers or
your customers’ personal information.

URL (Uniform Resource Locator) - The
global address of websites on the Internet.

VPN (Virtual Private Network) - A system
that takes two or more local networks and
creates an encrypted “tunnel” through the
Internet between them so they can securely
communicate.

WAN (Wide Area Network) - A network
that connects computers at many different
places. It’s usually much more diverse than a
LAN. The Internet is a WAN.

Web Page - A document on the worldwide
web that has its own address.

Web Server - A computer with data and
software designed to host a website.
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Macromedia Dreamweaver MX 2004 is a web design tool that allows you to create the layout of

your pages using simple visual tools. It’'s commonly known as a “What-You-See-Is-What-You-Get™
(WYSIWYG) editor. This means that what you see when designing your site in Dreamweaver is what

the page will look like when a visitor looks at your page in their internet browser. Basic web pages are
created in a format called HTML and have file names with an .html extension. Dreamweaver allows you
to visually create your pages without learning HTML. When you save your pages in Dreamweaver it does
all the work to convert your visual layout to an HTML file which can be viewed in an internet browser.

The following step by step instructions will allow you to create a very simple website containing a home
page, and a contact us page. To create a more advanced website, please refer to the more advanced
tutorials available in Dreamweaver under the ‘Help’ menu on the top menu bar.

[ ] 1. Open Dreamweaver MX 2004.

[] 2. Choose Sites » Manage Sites from the
top menu bar. A wizard window will popup
to ask you questions relating to your
website.

a. You will first be asked to enter a name
for your site — enter your company
name and choose Next.

b. Select No for server technology and
Next.

c. Choose “Edit local copies on my
machine...(recommended)” and
browse to a folder on your computer
where you want to keep your local
copy of your website files.

d. Choose ‘None’ for How do you
connect to your remote server and
Next.

e. Choose Done in the popup wizard and
Done in the Manage Sites Window.

[ ] 3. Choose File » New from the top menu
bar. In the General tab, select Basic Page
and HTML as the file type and click the
Create button. At the top of the new
window that is created, there are three
buttons labeled: Code, Split and Design.
The Code button shows you the HTML

code that defines your page. The Design
button shows the WYSIWYG editor where
you can visually design your page and the
Split button shows both the HTML and
WYSIWYG editor at the same time. For
the purposes of this example, choose the
Design view by clicking on the Design
button — you should now see a blank
window.

4. Choose Insert » Table from the top menu
bar. Enter 2 rows and 2 columns and 100%
for the width of the table in the popup
wizard, leaving all other options with their
default values. You should now see a table
with four cells in the window.

5. To insert your logo into the page, you
must first convert the logo image file

to a format which is usable by internet
browsers.There are several formats, and
each is suited towards a particular type of
image. Some of these are:

a. .GIF (Graphics Interchange Format)
— maximum of 256 Colours, excellent
for logos or simple images with text.
b. .JPG (Joint Photographic Experts
Group) — millions of colours, excellent
for photographic images.



c. .PNG (Portable Network Graphics)
— millions of colours, excellent for
complex logos or simple images with
text.

To convert your image, you will need

to use a graphics editing application

such as Microsoft Paint for Windows or
Apple Preview for Macintosh. Choose

an appropriate file format and set the file
size of the image small (typically < 30KB).
This can be a trial-and-error process to
get a small file size but retain good image
quality. Once you have your logo saved

in a web-ready format, you are ready

to insert this into your web page using
Dreamweaver. Click in the top left cell of
the table and select Insert » Image from
the top menu bar. Browse to the web-
ready logo file and click OK. Select Yes if
you are prompted to copy this image file
to your root folder. You should now see
your logo in the top left hand corner of the
table.

6. Enter your company name followed by
‘Home’ in the Title field of this window.
This will be the title which appears in your
visitor’s browser window.

7. Enter the text content for the home
page into one of the bottom table cells by
clicking in the cell and typing.

8. To help search engines with your

site, you should supply keywords which
describe your company. This is easily
done by selecting Insert » HTML » Head
Tags » Keywords. Enter a number of
keywords, most important first, separated
by commas. Click OK to finish.

9. Save this page to your root folder by
selecting File » Save, and ensure that the
filename is “index.html”. This is a special
filename which represents the default first

page of your website. Visitors, who enter
http://www.yourcompanyname.com into a
browser, will be presented with this page.

10. Create the Contact Us page by
repeating Steps 3 to 5. Click in one of the
cells of the table and enter your company’s
contact information (address and phone
numbers). Enter your company name and
‘Contact Us’ in the title field at the top of
the editor window.

11. To add a clickable link to your email
address, select Insert » Email Link from
the top menu bar. In the text field, enter
the email address in both the Text and E-
Mail fields and click OK.

12. Place a clickable hyperlink from the
contact us page to the home page, by
clicking in top right cell of the table and
selecting Insert » Hyperlink. Enter ‘HOME’
in the Text field and click on the folder icon
to browse. Browse to the index.html file in
your root folder that you created in step 9.
Leaving all other fields blank, click on OK.
You should now see a link labeled HOME
in this table cell.

13. Save this page with the filename
‘contactus.html’ by selecting File » Save.

14. To add a link to the Contact Us page
in the home page (index.html), let’s
switch views to the index.html window
by selecting Window » index.html (at the
bottom) from the top menu bar. Click in
the top right cell of the table and select
Insert » Hyperlink. Enter ‘Contact Us’ in
the text field and browse by clicking on
the folder icon to the contactus.html file
in your root folder that you created in step
13. Leaving all other fields blank, click on
OK. You should now see a link labeled
Contact Us in this table cell.
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[ ] 15. Save the home page ‘index.html’ by
selecting File » Save.

[] 16. You now have two pages of your basic
website each with your company logo and
hyperlinks that a visitor can use to navigate
from your home page to the contact us
page and back again.

[] 17. You can preview your pages in a
browser to see exactly what your pages
will look like to a visitor, but without
publishing your site to the internet. To
do this, select File » Preview in Browser.
Select the browser you normally use from
the list. Your browser should open and
display the home page as you designed
it in Dreamweaver. You can click on the
hyperlink for Contact Us to navigate to
the contact us page you created and then
on the HOME hyperlink to navigate back
to your home page. You can use this
feature to quickly preview your changes
in Dreamweaver without publishing your
changes to the internet.

[ ] 18. You have now created a very simple
web site.lt is recommended that you use
the Dreamweaver tutorials available under
the Help menu in the top menu bar to
learn more about how to use the advanced
features of the application.

To publish your site to your hosting provider’s
server so that your site can be viewed by
anyone on the internet can be done using
Dreamweaver. When you obtain a hosting
package, the hosting provider will have
provided several pieces of information
including the following:

e FTP (File Transfer Protocol) Server
Host Name

e FTP Username

e FTP Password

1. To allow Dreamweaver to upload your web
site to the hosting provider’s server, select
Sites->Manage Sites from the top menu bar.

2. Select the site you created in step 2 above
and click ‘Edit’. A new window appears.

3. Select the Advanced tab at the top, and
Remote Info from the category list. Then
select Access: FTP. You will now have a
series of fields to define the FTP for your
hosting provider.

4. Enter the FTP Server Name in the FTP

Host field, leave the Host directory blank.

Enter the FTP Username and Password in
the Login and Password fields.

5. Ensure that your computer is connected
to the internet and click the Test button
and Dreamweaver will try to connect to
the Hosting Provider’s server. Should this
fail, contact your hosting provider for more
information. If it was successful, continue
to the next step.

6. Dreamweaver is now ready to post your
web page files to the hosting provider’s
server. To start this process, open the Files
tab in the right hand tool bar. Ensure your
site is selected in the drop down box. Click
on the blue Arrow button that is pointing
upwards. Dreamweaver will now transfer
your files ‘Up’ to the hosting provider’s
server.

7. Test that your web site has been published
by opening your internet browser, and
entering the address for your website. For
example, http://www.mycompanyname.com.

8. You have now published your site to
the internet, and visitors use their internet
browsers to view your website.



It’s easy to get yourself up and running on online auctions. Follow these steps and you will be on
your way to promoting your products instantly to millions of potential buyers daily. eBay is the largest
online auction and is used as the example for this type of e-commerce.

[] 1. Start by getting an eBay user
account
Log on to and click to
register as a new user.

Pick a user name and password that
only you will know, but that you will
remember.

The registration process first asks you for
basic contact information. They do this to
verify that you are a real person so that
both you and others can be confident
that the transaction will be with a real
person on the other end and is not a
scam. Your privacy is guaranteed.

You will have to confirm the registration
by replying to an email confirmation
message eBay will send you. Simply
follow the instructions within the
message to confirm your registration.

[] 2. Create a seller's account

In order to sell on eBay, you must be
registered. It is free and easy.

[] 3. Gather your information
Put together the information you’ll need,
including: your item description, digital
photographs, the category you want
to list under (antiques, crafts etc.) and
the currency you prefer to list in (likely
Canadian).

[ ] 4. You're ready to sell

Click on the Sell button found at the top
of any eBay.ca page, log in, then choose
whether you want to list your item as an
auction or at a fixed price and whether
you would like to list in Canadian or U.S.
dollars.

5. Choose your category

Select one of the main categories by
ticking the check box beside the name
and then proceed to the next page
where you will choose in which sub-
category you would like to list.

6. Enter the product information
Enter a concise title and an accurate
description. Include as much information
as possible about the object — model
number, year produced, hours to make
it, colour, dimensions and the current
condition of the item.

When filling in the title field, make sure
to use key words that are descriptive
enough so that anyone viewing the title
by itself will understand what you are
selling.

Enter an accurate description and make
sure to be truthful.

7. Photos, duration and other
features

On the next page you can add photos

to your listing. You are allowed one free

graphic per listing. The more photos you
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have that accurately show what you’re
selling the better. After you have added
your photos, choose the listing duration,
your starting price and any special
features you would like to use.

8. Payment methods and shipping

Select what payment methods you
will accept and where you’re willing
to ship. If you select to ship your item
worldwide, it will automatically appear
on eBay.com and all other eBay sites
worldwide.

9. Review and confirm

On the final page you can double check
that you have not made any mistakes as
well as find out the fees associated with
your listing. If you need to, you can go
back and edit your listing. If everything is
OK, hit submit and your listing is live.

By providing complete and accurate
information in the shipping and payment
terms section, you will make things
much quicker for yourself and your buyer
at the close of the auction.

Before setting your starting price, look
at what similar items sold for on eBay.
You can do this by searching completed
items that you will find by using the
Search option in the top navigation bar.

Now your item is listed, being viewed,
and if someone bids, you are ready to
close the deal. Once a listing closes, no
more bids are accepted. At this time, the
seller is sent an email from

eBay.ca containing the winning bid price
and contact information for the bidder.
The buyer is also sent a notification email
containing the seller’s email address and
the winning bid price.

[ ] 10. Payment details for buyers

If you did not provide shipping costs in
your listing, your buyer may choose to
send you an email requesting that you
now provide this information. Keep in
mind that buyers are only bound to the
terms you specified in the listing.

For fixed price items, you can specify
the total for a buyer once they have
requested the total. It is important to
note that once a buyer clicks on the
buy-it-now button in a listing, your
inventory will be deducted accordingly,
even if your buyer has not completed the
payment process.

[ ] 1. Ship the item

After receiving payment, carefully pack
the item and promptly ship it to the
buyer. However, if the payment is in

the form of a personal cheque, for your
protection, you may want to wait for it to
clear your bank before shipping the item.

Be prepared to ship the item before it
sells. This is especially helpful if you are
listing many items on eBay at once.

Get going

You have now completed the steps to sell
items on eBay. However, it is important

to remember that eBay is a community.

Your reputation for being a good retailer is
important. Take part in the evaluation options
that are part of every transaction in order to
keep the community spirit going. It will help
buyers trust you, and help you trust buyers
too!



There are many types of online stores. In this sept-by-step example, we will use a popular
commercial software package from Maximizer called ecBuilder ( ) available for
Microsoft Windows. In this program there are 19 official steps to building your website and online
catalogue with Ecbuilder’s wizard set up program. These steps are very simple to follow and allow
you to enter key information about your business, services and products for sale. The wizard takes
you step by step through each screen of information required to the final screen where you are able
to publish your site and catalogue to the Internet.

[ ] 1. Site structure [] 5. Company identity

This is where you will choose the main
sections that will appear on your site.
Each main area can have a separate title
to it. This information will explain the
basic content of your site. It will include
the homepage, content and main sub-
pages.

2. Defining your company
information

In this section enter essential information

about your company’s physical and

Internet addresses.

3. Site builder profile

Enter the name and contact information
for the person who will be the technical
and administrative contact for posting
information and Internet services on your
site.

4: Contact profiles

Enter contact information for the various
people in your company or home who
will receive orders, inquiries and emails
asking questions about products or
services from your website.

This is the basic information that will
be displayed on the first page of your
website. This is where you will enter
your company’s slogan or mission
statement and a brief description of the
company and the products or services
you provide.

6. Home page content

This is where you can add customized
home page content with HTML. You can
also control the number of links included
for the content pages and catalogue
sections here.

7. Website content

This is where you will define your
company’s key marketing messages,
its products or describe any special
programs. You can add images and
media files to emphasize these pages.

8. Creating your catalogue

You may create a multi-tiered catalogue
structure depending on the Template
and Template Classes that are chosen
from within the Site Design and Preview
Page. The catalogue may have an
unlimited number of tiers.
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You can group the products and/or
services into multiple categories by
creating multiple catalogue sections that
contain even more sub-sections. You
may also copy and paste any catalogue
sections or catalogue items by simply
right-clicking your mouse on the item or
section. You may also drag and drop any
section or item by left-clicking on the
item or section, and dragging it to the
desired location.

9. Online processing

This is where you will configure your
Online Processing Payment Information
and Capabilities. In order for you to use
most real-time transaction processing
capabilities, you must first obtain and
install an email client digital certificate
on your computer. This certificate will
be used to encrypt and decrypt the
order information generated from your
customer’s online orders.

Once you have obtained this certificate,
you must enter it into the program
application. If you do not already have
a merchant account, you will have to
obtain one.

Once you receive your merchant account
settings, you can enter this information
into your program to configure your
website for real-time transaction
processing.

10. Payment methods

Enter the credit card types the website
will accept, as well as indicate whether
or not the site is willing to accept other
forms of payment.

[] 1. Currency

Select the type of currency you wish to
use for the orders generated from the
website.

You may edit the abbreviated currency
symbol which is used to display the
currency type for the catalogue items.

12. Order and inquiry fields

In order to assist the website in building
relationships with customers, you may
want to ask for specific information
when a shopper wishes to place an order
or make an inquiry.

For instance, you may want to ask
questions such as “Please specify your
annual household income:”, “How have
you heard about us?”, or “How often are
you buying this type of product?

13. Policies and statements

The Policy and Statements page is
normally used to publish your company’s
Return/Refund Policies, your Shipping
Policies, and your Privacy Statement.

Provide the appropriate title for each
section by selecting from, or editing,
the drop down list, and then enter the
policy or statement details in the fields
provided.

14. Web links

The Web Links page allows for the
creation of a list of multiple groups each
containing multiple website addresses to
be linked to.



[] 15. Advertising and statistics

This is where you would place banners
on the website that promote the
products or services of other businesses.
Banners can create benefits such as
increased credibility through affiliation,
as well as new branding and income
opportunities.

Banners can appear on the top and/or
bottom of the website. You can supply
your own banner with a link to another
website, or select a banner residing

on another website. Some banner
companies may also require the inclusion
of some HTML that they will supply.

Hit Counters help track the number of
visits to a website. A counter can be
included at the bottom of the home

page.

16. Site design and preview

The Site Design and Preview pages
allow you to customize the look and feel
of the website. You may either select
from the example Template Classes,
Templates, Skins, and Styles, or you can
create your own.

17. Business classification

The Business Classification will help
your business to appear in the correct
industry category listing located on

Select keywords that specifically
identify the type of business, products
or services your site offers. These
keywords are used as part of the
information that will be submitted to
various search engines.

[] 18. Search engines

Search engines will help customers find
the website on the Internet.

Enter the URL of your website and select
the search engines to submit to. When
you first upload the site, the ecBuilder
program will submit the website
information to the selected search
engines.

You will only need to submit the website
to the search engines once every few
months, or if the content on the website
dramatically changes.

Some search engines will accept
submissions only once every 60 days or
s0. Submitting the website more than
once within this period may cause these
search engines to reject the website
because they perceive it as “spamming”.

19. Publish your site

In order to publish the website on the
Internet, you must first enter the correct
User ID, Password, FTP Server address,
and a directory name by selecting the
appropriate Radio button, and then
selecting Publish.

If you do not already have an account,
select the first option, click on the Publish
button, and then select the Acquire Host
Account button to be taken to a web
page listing the Multiactive Website
Hosting Partners.

The hosting provider will supply you with
an optional website address, a User ID
and Password combination, and space
for your website.
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Online malls can help make smaller businesses very successful selling online.They are like renting
a traditional retail location in your local shopping centre - you pay a monthly fee for the online “real
estate”. Online malls like Yahoo! Store will bring in traffic and visitors to your website. The monthly
fee is often compensated for by lowering your marketing and advertising costs.

]

1. Sign up for Yahoo! Merchant

Solutions
Choose one of the three packages
available. A comparison chart is available
at

One of the

differences in the packages is receiving
orders by fax which may be important
if you are not online all the time to
check your email. Another difference is
handling gift certificates.

2. Manage my services

Once you’ve signed up for a merchant
solution package, (this is your online
credit card and payment system such as
PayPal) you will have access to configure
the following services:

e Web hosting and site design features;
e Store inventory, orders, and reporting;

e Mail accounts and storage
preferences; and

e Domain management.

There is plenty of information to help

with this and customer support is

available 7 days a week using their toll-

free number.

3. Prepare to accept online payments
You must have a merchant account
open for your business to process credit
card transactions. You can sign up for

an account through any number of
providers including the Yahoo! partner,
Paymentech. Be sure to establish your
merchant account early so that they are
available when you’re ready to open for
business.

4. Organize and load your products
into the Catalogue Manager

The Catalogue Manager is a powerful
built-in tool that allows you to manage
your inventory of products, including
pricing and detailed information about
each item. You can enter your products
one by one or upload them from your
own database or spreadsheet.

5. Plan and organize your website
content

To establish a reputable web presence,
you will require clear content that makes
your products sound appealing, and

sets expectations for your customers.
You'll find it’s easier to build your store
if you carefully outline your website and
write out the necessary content prior

to building your pages. Don’t forget to
define the important details such as
privacy statements, refund policies, etc.



[ ] 6. Startbuilding your store

Once you have planned out your store,
it's time to actually build the web pages
of your online store. There are two online
tools provided by Yahoo! Store Editor
and Yahoo! Site Builder. Both allow

you to design the pages of a simple
online store. The pages of the store

can also be designed using third-party
tools such as Microsoft FrontPage or
Macromedia Dreamweaver. For complex
stores, you may require the services of a
qualified web developer to assist you in
converting your store design on paper to
your Yahoo! online store.

7. Set up back-end systems and
operations

You can configure your Yahoo! Store to
automatically set up tax and shipping
options to handle out of province/
territory/country transactions. You will
need to consider how your products will
be shipped to your customers, and what
shipping rates will apply. There are a
number of shipping companies that have
tools that can be integrated into your
Yahoo! store to make this convenient
for both you and your customers. UPS
for example can be integrated and can
provide your customers with a tracking
number for their order which allows the
order to be tracked online using the UPS
website. You can also determine how
you would like to receive orders: online,
email or fax.

8. Open for business and attract
new customers

You will need to consider methods to

attract new customers to your online

store. Yahoo! offers marketing services

to attract customers to shop in your new
online business.

[] 9. Accept and manage your orders

As soon as you open, customers can
start placing orders. Depending on the
preferences you’ve established, you
can receive these orders via the Store
Manager, fax, or email, and process the
orders accordingly.
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Subscription - based websites are a great e-commerce solution if your business is providing

information. Like a magazine subscription or a library card, these websites allow customers access to
information in exchange for ongoing payments. Not every product or service suits this model. Talk to
an expert if you are not sure.

[l

1. Choose a subscription
e-commerce solutions provider

There are a number of competing
subscription type e-commerce solutions
providers with a focus on different types
of content delivery. If you were selling an
electronic book for example, you would
want a provider who could allow secure
access to download an electronic copy
of the book (typically an Adobe Acrobat
PDF) only to users who have paid online.
If you had a private subscription-based
website then a provider who would allow
paying users access to read online would
be preferable. Another option would be
to contract a web developer to develop

a custom solution that suits your specific
product or service.

2. Decide what payment
method(s) you wish to offer
and choose a merchant account

Payment methods could be by PayPal,
Visa, MasterCard, American Express,
cheque, etc. You need to define which
methods you want to offer, and then
choose a merchant account provider
that is compatible with your hosting
provider. PayPal and other online
payment systems offer tools that can
be integrated into your site to allow
customers to purchase a subscription
and then be given access to your
services and/or products for a specified
period of time.

[] 3. Design your site, considering

how you wish to deliver your
services and/or products

Your services and/or products may be
delivered in one or more formats. For
example, a novel could be delivered as a
hardcopy book, an audio CD, a PDF file,
or only for viewing in a web browser.

A news article could be presented in a
browser, or in a PDF file, a video, or an
audio file. You will also want to consider
providing a sample of the content
available through subscription so that
potential customers can appreciate

the value of the subscription. You may
provide excerpts of written content,

or audio or video clips of multi-media
content. Don’t forget to define privacy
statements, refund policies, etc.

4. Encourage repeat business
through advertising

Since the subscription based
e-commerce model is based on repeat
business, you will want to establish
online advertising which will encourage
existing subscribers to re-new their
subscription at the end of the term.
Some newspapers will encourage
subscription renewals with discounts to
repeat customers. As the relationship
with your customers is on-going, you
may wish to solicit their feedback so
that you can ensure your customers are
satisfied with your service.



Step-by-step: PayPal

To set yourself up to accept all major credit
cards instantly, all you need to do is go to
www.paypal.com and register by signing

up for a new account.
Follow the easy-to-use instructions and then
fill in your bank account information. Have
this information (account number and branch o —ed T -
information) ready and available before you — e e v gt e
go to sign up. A credit card is not essential ___:_:'."_.__. e - =
for using PayPal but will make it much Emeer, = E-'—T_—'—':"'_“""' m
quicker to send and receive money. g Moess -

B () DN e '5
Once you have filled in your account S— i
information, you will be required to confirm T

that this is really your bank account. In the

account information page, there is an option
to confirm your bank account. After clicking
on this option, PayPal will send two tiny Rt
deposits into your bank account. Get your %
account statement online or when it arrives
in the mail, note which of the transactions

listed were the deposits by PayPal. You w P ——
will need these to complete the steps of = ———
verifying your bank account in the account =
manager screen. o [ A . |

When you have verified and confirmed your
account through this easy process, you

can then start depositing money from your
PayPal account to your bank account.
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